<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Logging onto the Trading Platform</td>
<td>2</td>
</tr>
<tr>
<td>Trade Interface Heading</td>
<td>3</td>
</tr>
<tr>
<td>Trade Chart Heading</td>
<td>4</td>
</tr>
<tr>
<td>Opening a new Trade Chart or Trade Window</td>
<td>4</td>
</tr>
<tr>
<td>Trade Window Heading</td>
<td>5</td>
</tr>
<tr>
<td>Logging onto a Data Feed and Selecting a Contract Using Profiles</td>
<td>5</td>
</tr>
<tr>
<td>Menu Options</td>
<td>7</td>
</tr>
<tr>
<td>Trading</td>
<td>7</td>
</tr>
<tr>
<td>View</td>
<td>8</td>
</tr>
<tr>
<td>Options</td>
<td>8</td>
</tr>
<tr>
<td>Charts</td>
<td>9</td>
</tr>
<tr>
<td>Help</td>
<td>9</td>
</tr>
<tr>
<td>Trade Buttons</td>
<td>9</td>
</tr>
<tr>
<td>Buy Market</td>
<td>10</td>
</tr>
<tr>
<td>Sell Market</td>
<td>10</td>
</tr>
<tr>
<td>Buy Bid</td>
<td>10</td>
</tr>
<tr>
<td>Sell Ask</td>
<td>10</td>
</tr>
<tr>
<td>Buy Ask</td>
<td>11</td>
</tr>
<tr>
<td>Sell Bid</td>
<td>11</td>
</tr>
<tr>
<td>Long Entry</td>
<td>11</td>
</tr>
<tr>
<td>Short Entry</td>
<td>11</td>
</tr>
<tr>
<td>Long Exit</td>
<td>11</td>
</tr>
<tr>
<td>Short Exit</td>
<td>11</td>
</tr>
<tr>
<td>Reverse</td>
<td>11</td>
</tr>
<tr>
<td>Flatten</td>
<td>12</td>
</tr>
<tr>
<td>CancelALL</td>
<td>12</td>
</tr>
<tr>
<td>Order Window</td>
<td>12</td>
</tr>
<tr>
<td>Layouts</td>
<td>13</td>
</tr>
<tr>
<td>Support Option</td>
<td>15</td>
</tr>
</tbody>
</table>
Introduction

This document will explain how to logon to your Trading Platform. All the Trading Interfaces (the Trading Chart and the 3 different Trade Windows) use a Profile to logon to your data feed and the contract you want to trade.

Everything you need to use your Trading Platform is accessed from the Menu at the top of the Trading Chart and Trading Windows. This will introduce you briefly to the options available from the Menu. More detailed information will be supplied in documents specific to each topic.

Logging onto the Trading Platform

Click on the desktop icon to logon to your trading platform.

The logon window will open:

1) Enter your **UserName** created from the Portal on the Home tab.

2) Enter your **Password**.

3) The **Layout** will be blank the first time you logon. You can name your Layout from the Trade Chart or Trade Window.

4) In most cases you can leave **Logon Options** unchecked. You will be logged onto a default server.
   - If you check “Logon Options” a drop down menu will give you a choice of 3 servers to logon onto. You only need to check this option if you are having trouble with the server you are currently logged onto.

   ![Server Choice](server_choice.png)

   **Note:** You cannot be logged onto the with the same UserName/Password combination on 2 different servers. This will cause problems with chart backfill data.

5) Click **OK** and a default **Trade Chart** will open.
Trade Interface Heading

The Trade Chart is the first Trade Interface you will see on your Trading Platform. From this Trade Chart you can open other Trade Charts and 3 different types of Trade Windows.

The Trade Chart and the Trade Window have similar headings and drop down menu options.
1. Trade Chart Heading:

This shows the important information about your chart data.

1) **Time Frame** of chart: This example shows a 30 second chart
2) **Countdown timer** for the current bar. This example shows 20 secs left on the 30 second bar.
3) **Name of Profile**: S&P emini in Simulation mode, This is a default profile set up for the S&P emini.
4) **Contract Name and Date**: This shows the S&P emini with September expiration

**Opening a new Trade Chart or Trade Window**

To **open a Trade Chart** click on **Trading**, select "**New**" and then select "**Trade Chart**" and then select the type of Trade Chart you want to use.

To **open a Trade Window** click on **Trading**, select "**New**" and then select "**Trade Window**" or "**Trade Window 3.x**".
1. **Trade Window Heading**

The Trade Window does not show any time frame or countdown timer. It does show your Profile name and the Contract with its expiration.

You can open a new Trade Chart or Trade Window from the Menu at the top just as you can from the Trade Chart.

### Logging onto a Data Feed and Selecting a Contract Using Profiles

The **Profile** is the interface connecting you with your data feed and trading contract.

You can create as many Profiles as you want to reflect basic information about what is being traded. You could include the name of the contract being traded, whether you are trading live or sim.

The Profile window is where you can select Profiles and create new Profile names. You can select your data feed and decide if you want to trade from your account or practice Sim Trading.

This is where you select your contract and expiration date for that contract. The exchange where the contract is traded is automatically selected for you.

1) **Select Profile**: There are a few basic Profiles that come with the Trading Platform to get you started. You can see these when you click the arrow.

2) **Pricefeed**: Select your pricefeed from the drop down list.
   1. Use “Price” for **sim trading** or **Live trading**.
   2. Use “Replay” for playing back **historical data**.
3) **Trading Backend**: Select Sim Trade if you want to simulation trade so there is no money at risk. Profile window will stay green to indicate sim trading.

Select the pricefeed that is connected to your broker to trade Live. This will put your money from your account at Risk. Profile window will turn blue to indicate Live trading.

4) **Create a new Profile** – Click the “New” button and a window will pop up where you can enter any Profile name of your choice.

   You can name your profile anything you want to remind you of your trading methodology connected with that profile.

5) **Delete a Profile**: Clicking this button will delete a Profile from your Profile list. This cannot be undone. You must create a new profile again.

6) **Cancel button**: This will cancel any changes you made and close your Profile window.

7) **Logon/Logoff Pricefeed**

   1. The **blue Profile window** shows that a **Live pricefeed** is selected.
   2. The **green Profile window** shows that a **sim datafeed** is selected.
   3. Clicking the “Logon” button **connects you to the pricefeed** you selected.
NOTE: You cannot logon to the same Profile in different Trading Interfaces. If you try to Logon to a Profile that is already logged on, a notification window will pop up.

4. Click the “Logoff” button to **disconnect the Trading Platform from the pricefeed**.

5. **Select the contract** from the drop down list of contracts you have permission to trade from your broker.
   - NOTE: Trial Users will see a small list of contracts to practice sim trading.
   - Click the “Select” button to activate your contract selection.

6. Select a contract expiration date.

7. The exchange your selected contract is traded on is automatically displayed here.

**Menu Options**

You can access all functions of the Trading Platform from here.

1. Trading

From the **Trading drop down menu** you can access your Profile, open **Trade Windows, Trade Charts, Quote Screens, Order Strategies, Automated Trading** (Strategy Builder), **Institutional Volume Filter (IVF)**, and **Alerts**.

You can **save your Profile**, save your Profile by a different name, **save your Layout** and **exit** the platform from here.

*Strategy Builder will only open when you have signed up for the Auto Version or the Professional Version.

** IVF is only available when you have signed up for the Professional Version.
2. **View**

From the **View drop down menu** you can access your **Account**, **Order Window**, you can **refresh your orders**, see **Bar data** on individual bars on your chart, and access your **Profit/ Loss window**.

3. **Options**

The **Options drop down menu** gives access to the **Application Options window** where you can do a multitude of things from customizing your order windows, charts, trade windows, sounds, logon/logoff options, colors and fonts on charts and trade windows, and work with order entries.

You can also access **options for your data feeds** from here.
4. Charts

From the Charts menu you can open various standard charts with or without different indicator panes. Depending the permissions you have purchased there will be options to open other pre-formatted charts as well.

5. Help

From the Help Menu you can access the Portal page where you can change your password, add or change permissions, change credit card info, cancel your subscription and access instructions for using your platform.

You can also open your Remote Support window, send your log files and see the current version of your software.

Trade Buttons

There are a variety of Trade Buttons on the Trading Interfaces.

The Standard Trade Window has Buy Market, Sell Market, Buy Bid, Sell Ask, CancelALL, Reverse and Flatten.

The Trade Window 3x has all the buttons on the Standard Trade Window plus Buy Ask, Sell Bid. You can access Order Strategies from this Trade Window by clicking the Long Entry, Long Exit, Short Entry or Short Exit trade buttons.

The Trade Chart has 2 different sets of trade buttons depending on the Trade Bar Layout you choose.

- The Strategy trade bar layout has fewer trade buttons. You can choose an Order Strategy that allows you to Buy Market but there is no Buy Market trade button. The only trade buttons to place trades are Long Entry, Short Entry, Long Exit and Short Exit.

- The Full trade bar layout has all the trade buttons.
1) **Buy Market**

This button places a Buy order that goes to the head of the line at the Exchange immediately guaranteeing a fill at the current Ask no matter how quickly the market is moving.

2) **Sell Market**

This button places a Sell order goes to the head of the line at the Exchange immediately guaranteeing a fill at the current Bid.

3) **Buy Bid**

This places a Limit order to Buy at the Current Bid. The market would have to go down a tick to get filled. There is no guarantee of getting filled if the market continued to go up after placing your order. (This button is not available on the MultiDome.)

4) **Sell Ask**

This places a Limit order to Sell at the Current Ask. The market would have to go up a tick to get filled. There is no guarantee of getting filled if the market continued to go down after placing your order. (This button is not available on the MultiDome.)
5) **Buy Ask**

This places a Limit order to Buy at the Current Ask. Most of the times your order will get filled immediately. However if the market moved up very quickly there is a possibility of not getting filled because a Limit order is meant to fill your order at that price or better. Optimally you want to buy at a lower price.

This button is not available on the Standard Trade Window or MultiDome.

6) **Sell Bid**

This places a Limit order to Sell at the Current Bid. However if the market moved down very quickly there is a possibility of not getting filled because a Limit order is meant to fill your order at that price or better. Optimally you want to sell at a higher price.

This button is not available on the Standard Trade Window or MultiDome.

7) **Long Entry**

This button will execute any Entry Strategy that is selected from the drop down list of Order Strategies on your Trade Window 3x or Trade Chart. It will place a Buy Order. (Not available on the Standard Trade Window or MultiDome.)

8) **Short Entry**

This button will execute any Entry Strategy that is selected from the drop down list of Order Strategies on your Trade Window 3x or Trade Chart. It will place a Sell Order. (Not available on the Standard Trade Window or MultiDome.)

9) **Long Exit**

This button will execute any Exit Strategy that is selected from the drop down list of Order Strategies on your Trade Window 3x or Trade Chart. It will place a Buy Order. (Not available on the Standard Trade Window or MultiDome.)

10) **Short Exit**

This button will execute any Exit Strategy that is selected from the drop down list of Order Strategies on your Trade Window 3x or Trade Chart. It will place a Sell Order. (Not available on the Standard Trade Window or MultiDome.)

11) **Reverse**

Clicking the Reverse button initiates the following actions in order:

1. Flattens your position
2. Cancels all working orders
3. Places a new position (the reverse of your previous position)
4. Adds any Profit and/Loss targets that are selected on your Trading Interface at the time you click on the “Reverse” button.
Note: If you changed your Order Strategy, MOT or Profit/Loss ticks from your original position that you are reversing, the newly selected profit and/or loss targets will be placed with your reversed position.

12) Flatten

- The Flatten Button will get you out of your TOTAL current position and cancel ALL existing orders. This button is on the Full and Strategy Layout Chart Tool Bar.
- This button works in Chart Mode and Trade Mode.

13) Cancel ALL

This button cancels all existing orders. This is a great tool to make sure there are no pending orders that are out of visible range on your Trading Interface.

**Order Window**

From the “View” menu at the top of the chart select “Order Window”.

This window allows you to view all your open and closed orders.
1. The orders in the **top pane** are your **working orders**.  
   A red row represents **Sell orders** as shown in the picture above.  
   A blue row represents **Buy orders**.

2. The orders in the **bottom pane** are your **filled orders**.  
   A red row represents **Sell orders**.  
   A blue row represents **Buy orders**.

3. Click on a row to highlight that row. Hold the “Shift” or “Control” key on your keyboard to select multiple rows.  
   When the orders you want to cancel are selected, click the **“Cancel Selected”** button. This will cancel only the orders highlighted and leave the rest of the orders not selected.

4. Click the **“Cancel All”** button to cancel all the pending orders you see in the top pane.

5. If you want to show orders from ALL of your accounts, leave ALL in the window. (This is the default setting). If you only want to see orders from one account, click on the arrow and select the **Account of your choice from the drop down menu**.

6. Check the **“Show Fills Only”** box and the cancelled orders will disappear from the Order View window **showing only your orders marked “Filled”**.

7. You can **save your FILLED orders to an Excel file** by clicking this **“Save Fills to Excel”** button. This will not show your cancelled orders. You can name the file and save to any location on your computer.

8. Click on the **“Print Completed”** button to print your **completed orders**.

9. You can **change the font size** of your **Active and Completed orders** by clicking the up or down arrow. This can make it easier to see your Active vs Completed orders by making the fonts different sizes if that is your preference.

---

**Layouts**

You can name and save your layout. There is no saved Layout by default. When you upgrade your Trading Platform you will need to select a layout the first time you logon after upgrading.

Layouts save everything in your Trading Platform that can be saved:  
- Profiles  
- Charts  
- Order Strategies  
- UserName and Password from your broker
Multiple Order Target strategies
Chart Templates
All logged on Profiles with their charts and their locations on your desktop (Auto Logon at Startup should be checked in Application Options)

You can share Profiles, Order Strategies etc by sending a Layout to a colleague.

Remember to delete your Broker UserName and Password from your live pricefeed Options before you send your Layout file if you do not want your colleague to have access to your live account.

You can create different layouts for with different charts, Trade Windows logged onto specific Profiles and any other trading tools you want to use with Trade Platform.

You can name your layout by date, by strategy or anything else that will help you to remember a particular layout.

Examples:

1) You might want to create a Layout for scalping with a few Trade Charts opened with short time periods like 30 seconds and 60 second charts. You could name this Layout “Scalping”.

2) You might want a Layout saved called Swing Layout for longer trades with a few Trade Charts or Trade Windows and Charts with longer time periods like 5 minute and 30 minute charts. You could name this Layout “Swing Trading”.

3) You might to create a Layout for trading the emini Russell and only have Trade Charts, Trade Windows and charts opened for the emini Russell with different types of charts. You could call this Layout “Russell”.

Then when you logon to Trade Platform you would select one of these Layouts that will open with the appropriate charts etc. that you would need for the specific trading you want to do that day.

When you log off your trading platform a window will automatically open asking if you want to “Save & Exit” or just “Exit”.

If you choose Save & Exit this will automatically save your layout under the same name of the layout you logged onto the platform with.

If you choose “Exit” any changes made during this session will not be saved.

When you logon to your trading platform you will have the option to choose any saved layout to open. A drop down menu will open when you click the arrow. Select your layout and click “OK”.

Meeting Costs and Requirements:
- A minimum of 20GW or 200MW of generation capacity is required to meet this type of facility's needs.
- A single point of contact for the system is necessary for efficient operation.
- Access to an existing infrastructure is beneficial for reducing construction costs.
- A dedicated transmission line is preferred for reliability and efficiency.
Note: You can only change from one Layout to a different Layout by logging off your Trade Platform. Then select a different Layout when you logon to your Trade Platform again.

Support Option:

The Remote Support icon installed on your desktop is a tool you can use when you are talking with support on the phone. They will instruct you how to use this option.

This will allow the tech support person to view your desktop. When you are connected to the tech support representative you will see a small icon on in your Windows task bar.  

You can right click on this icon at any time to end your session with Remote Support.

The tech support representative cannot connect to your desktop unless you initiate the connection from by clicking on a “flavor” in the Remote Support window.